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research project. 
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DISCLAIMER: 
J&J does not make IBI analysis software. We do however have a new 'ad-on' option that - if checked- allows researchers to use other 
IBI software to explore sequential IBIs. This mode of IBI  data-save  was designed for those doing scientific research using the IBI 
data analysis. 
 
IBI-derived HRV s software  is available from Vrije Universiteit AMS. You must obtain their permission to use their  IBI-Analysis 
software.  It can  be used by researchers  for research purposes. It can also be used by clinicians and sports professionals for 
research. See their website for qualifications. 
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Kubios Analysis is a software program that takes raw IBI data and converts it to standardized HRV 
plots, a standard required for the publication of HRV research. 

We are pleased to provide this guide to converting Physiolab data for use in Kubios’ HRV analysis 
software. Kubios has published a new version which is very powerful. If you have the old version, got to 
their website, register, obtain permission, and download it. 

This manual is a generic guide to the  general features of  Physiolab-inspired software for the 
physiological signal detection of HRV spectral activity derived from IBI [ interbeat interval] data. 
 
Physiolab Applications using IBI have their own manuals. 
 Use this basic manual as a general introduction and reference manual as you navigate 
specific applications. 
Visit our information website for updates, revisions, and new information:  physiopilot.com 

 
REQUIREMENTS: 
 
C2-Series PHYSIOLOGY HARDWARE ONLY: 
You must have one of these units to do Physiolab conversions to Kubios HRV.  
These are the only units that run on the Physiolab software platform. 

• C2 Plus 6-Channel 
• C2 Plus 12 Channel 
• C2 GP – RV2 compact unit  
• C2 GP – EC  compact unit 
 

 
 
DOES YOUR SOFTWARE ALLOW YOU TO SAVE IBIs?: 
 
Even having the right hardware is not enough. You must have a software application which 
records and saves IBI signals properly. Only Physiolab-based software is capable of this. 
However even Physiolab software must be of the latest type, 
We have made several special editions of our HRV series software for a large number of 
clinics, hospitals and research teams. We estimate that there are at least 50 different versions 
of our software in various institutions that will run our IBI save routine. 
 
The following Physiolab software we optimized for IBI Kubios Analysis: 

1. the C2 Plus Second Generation Bundled Software. 
a. Any application that has ECG in it will also detect and save IBIs for Kubios. 

2. The new Physchophysiological Stress Profile [PSP]. 
a. It is structured with all the same signals as Research Mode. 
b. If you just want IBIs for Stress Testing, bypass Research Mode and use the PSP. 

3. The new  BioConnect family/group HRV software. 
a. NOTE: I have not tested the new Kubios with group IBIs.  
b. Test 2 persons and let me know if the data is useable in the new Kubios. 

4. The new C2 GP EC compact units.  
5. The new C2 GP RV2 compact devices. 
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a. These compact research-focused devices both detect IBIs. The ECG unit [EC] 
detects IBIs from the ECG, while the PPG unit detects IBIs from the pulse wave 
spikes.  

 
 
NOT SURE? DO THIS TEST WITH THE SOFTWARE YOU ARE USING: 
For other software, here are some things to know and a way of testing: 
Physiolab applications made before 2008 do not have this feature.  
Not all software released after 2008 have this feature. 
To find out if your software has this feature, just run it. Press the RUN button, and collect a 
minute of heart rate data. Then go to the Save Data screen, Save to Database, then Export. 
From the Export Screen, Select HR/IBI, add a directory folder to receive the IBI data, and 
press save. 
Use a file manager like Windows explore and see if you get a new file in the selected directory, 
with and .asc extension. If you do, open it in Excel. You will see a single row of numbers, each 
number an inter-beat interval in milliseconds. 
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Selecting Physiolab Software for IBI Analysis 
Configuring the Software 
Set Up the Software to Detect Your Hardware Model 
You will need to follow the instructions below after your initial installation and after each 
software upgrade.  

• Click on one of  the Physiolab desktop icons to get to the opening window.   
 

• Click  Run Session to bring up the Select Application window.  

 

 
 
IMPORTANT: 
To make IBI saves easy, always 

select a client first. Then, when you go to save as IBI, the clent name – or research ID 
name- will automatically be set up.  
 
SELECT CLIENT 
To begin running an application click on the icon from your desktop.  The program will load to 
the Main Menu. 

 

 
Click on Select Client.  Select a client name in the “Select Client” Window. Recorded session 
data will be saved under this client name. Click the “Select” button.  If you skip this step, you 
will be prompted later to select a client if you record data.  (For information on adding new 

clients, editing, and deleting client records, please see the “Adding and Deleting Client 
Information” section.) 
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RUN SESSION 
 
Next, click on Run Session. This will bring up the Select Application window. 

 
Make sure that the PHYSIOLAB device that you have connected to your computer is selected 
in the “Hardware Type” drop-down box.  Each hardware type has its own unique application 
list.  Click on the name of the application that you wish to run.  Click Start. 
 
If you receive an error message, click OK; check the connection to your computer, then retry. If 
you have trouble starting a session, please refer to the “Troubleshooting” section in your 
Hardware Guide.   
IMPORTANT: Once you have started an application you must exit it using the arrow in the 
lower left-hand corner, NOT the red X in the upper right-hand corner. 
 
Ensuring a Good Connection 
This section only applies to those users who detect IBI using the  ECG wrist-to-wrist sensors. If 
you are using the RV PPG sensor, impedance does not apply. 
 
For ECG, skin prep is critical. For researchers, we recommend a gelled electrode. The best 
placements are across the chest. For clinicians, we like our gelless wrist-to-wrist ECG 
electrodes.  Use alcohol on the skin and on the electrodes to keep them moist. Some 
combine alcohol and salt water, in dry climates. Be careful not to form a moisture bridge, which 
shots out the electrodes. 
 
In every application session, the first screen you will see is the Sensor Test Screen. Hook up 
the sensors using the picture as a guide.  Please refer also to your Hardware Guide for 
information on cable/electrode configurations for your device and connection tips for different 
modalities. 
 
IMPEDANCE: The Sensor Test Screen displays the impedance of each ECG electrode as a 
bar graph.  The digital bar values are in K Ohms (K=1000 Ohms).  J&J’s impedance testing 
feature is important because it enables you to determine the quality of your signals. High 
impedance levels allow environmental electrical noise to contaminate your signals.  Values in 
the green range indicate optimal functioning, yellow indicates marginal functioning and red 
indicates that the connection is inadequate and needs attention.  (Please see the “Impedance 
Testing” section of your Hardware Guide.) The bar colors are intended as guidelines only.  The 
values needed to ensure good signals are dependent upon the amount of electrical noise in 
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your location and the signal level of interest.  (For more information please see the “Artifact 
Detection” section in your Hardware Guide.)  

Are the Electrodes making good contact? 
• Simple Impedance Test: Remove completely from the skin. 
• Find a greed ground electrode. 
• Use either the green electrode on the 3-wire ECG  the Green 

finger skin conductance electrode on the SC cable. 
• Snap on 3 electrode pellets. Put some gel on them to increase 

conductance. 
• Touch the positive electrode to the green ground. 
• The Impedance Bar should go down into the green. 
• Touch the positive electrode to the green ground. 
• The Impedance Bar should go down into the green. 

 
• If no color change or 'break' continues, the cable or snap connect 

is cut or degraded. 
• If not, the problem is in the skin preparation. The alcohol or cream 

or gel must SATURATE abraded skin and form a moist connection. 
 
Are you really preparing the skin properly? 

• Skin can be dry or oily, clean or covered with lotion or makeup. It does not matter. 
ALWAYS 'abrade' the skin with a pad, using circular motions. And scrub hard - the skin 
should look red. Use an abrasive lotion. Use alcohol to remove residue, and scrub in 
circles with a dry pad. The idea is to remove dead skin. 

• Ready? Do not put the electrodes on yet. Use a cue-tip to put a dab of electrode gel on 
the spot where the electrode will be placed. Spin the gel into the skin. 

• Place the pre-gelled electrodes over the sites and ask the client to press hard around 
the edges. 

• Now test impedance. 
• Remember that impedance is proportional to the degree that the alcohol or gel merges 

with the skin. Often as the skin warms the gel makes better contact and impedance 
improves over 5 or 10 minutes. 

 
• Low EEG Impedance is most critical! 

o Poor EEG impedance .will generate artifact that is amplified in the low delta-theta 
frequencies. Your 'neurofeedback' training could be biased, giving false 'theta' 
bursts. EEG impedance. 

 
•  EMG is less critical, and ECG even less. The key to ECG is getting a clear R-wave for 

the IBI detector. 
 

• Signal bars for modalities other than EMG/ECG/EEG display green for normal 
operation, yellow for needing adjustment, and red for disconnected or broken.  

 
For devices powered by batteries, a digital battery indicator display near the bottom of these 
screen tests and displays the remaining voltage. 
 



PHYSIOLAB Engineering 2009 - USE3 Plus USERS MANUAL page 8 of 50 pages. 
 

Checking For Good Signal Data 
Click on Check Signals.  

• This screen displays all signals available in the application and currently being 
acquired so that you can inspect them to verify that they appear in normal 
ranges.  It is not intended for feedback.   

• In Applications with ECG, it includes a frequency spectrum (FFT) display 
which is particularly useful for detecting environmental electrical noise.   

o Remember that the ‘live HRV’ spectrum is flat for the first 64 beats. 
Mathematically it takes 64 beats for the spectrum to emerge. From then 
on, it updates beat by beat for the preceding 64 beats. 

o  
Sensor Test and Check Signals are designed to ensure the quality of your data.  
You should check these functions each time you start an application. 

 
Session Control Toolbar 
All HRV researchers need to record and save their data.  Recording can be started manually 
OR  - IN SPECIAL APPLICATIONS – BY PRESSING A SCREEN BUTTON. 
 
Physiolab applications do this manually by pressing the Run button to Record. Press it again to 
stop. Then select EXIT to save. 
 
Special applications like Resonant Frequency Test in the EC application library require that 
you do not press the red Run button. Instead you press a large button on the Select Task 
Screen. Once pressed, it will automatically take care of recording, pausing for instructions, and 
ending a sequence of tasks. 
 
Here is a review of key buttons to manipulate and control a session and its screens: 
 
The Session Control Toolbar at the bottom of your screen provides controls for specifying 
tasks, recording data, marking events in the data, and for invoking various screen features 
such as screen freeze and sweep reset. 
 

 
 

Exiting a Session 
 
This step is critical. If you fail to save properly, you will loose your data.  
 

Exit each session using the arrow in the lower left hand corner   
• In order to review data, generate reports, export data into a database, manage client or 

session data, or to quit the program, you must first exit the session.  In order to exit the 
software both the Pause and the Record buttons must be OFF. If you have recorded 
data, the Save Session Data window will automatically open when you exit the software 
(See the Saving Session Data section). 

  EXITING A SESSION  
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EXITING SOMETIMES REQUIRES TWO OR THREE STEPS.  
The key is to follow the instructions in the bottom Information Bar's BLACK BOX. 

• EXIT when CLEAR: 
• If the box is blank ………... , or says a simple ‘pause’, like this. PAUSE  just press EXIT 

.  
 
PROBLEMS EXITING – and SOLUTIONS: 
 

• However-If box says REC.  First STOP RECORDING:  

• If box turns blank   ………..  . press  EXIT  
• However If box says PAUSE 1:33 remain, , your Task Sequence is still enabled. 

 
To abort, first GET OUT of Pause. Press the grey toolbar [] []  Pause button.   REC resumes. 

This is correct. When REC resumes, click on the red Rec Button .  
The black box will clear and Now you can EXIT.. 

Recording Data 

• The Record button  toggles recording on and off. NOTE: The color difference 
between on and off is hard to see. Look on the black event box on the bottom center 
toolbar  to see if it says REC. or is blank  

 

• The Pause button  pauses data recording. Re-click it to resume recording. Look on 
the black event box on the bottom center toolbar to see if it says PAUSE . or is blank  

 

o The Menu button  allows you to specify the erase time interval invoked by the 
Record Backup button.  

o The Record Backup button  erases a specified time interval of recorded 
data, and records over the erased portion so that the data record is seamless.  
You can change the Backup interval using the Menu button. 

o The Task Averaging   button opens a window that lists the mean average for 
each signal and each task as it is recorded.  It verifies what is being recorded. 

 
Event Marking 

• You may use the event marker to make brief notes while recording. These notes are 
saved, and will appear in the Excel spreadsheets. The notes will not be seen in the 
saved IBI data folder. 

• The Event Mark button  enables you to add data markers into the recorded data 
when significant events occur during the session.  The button pops up a window into 
which you can type a name or brief comment which is inserted with the marker into the 
data record.  
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• Character limit for marker label is 3 characters, like ‘123,’ ‘abc,’ or ‘bl1.’ 
•  

 
END OF SECTION
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Saving Session Data, Saving Last Settings & 
Verifying Client Names 

 
Always save to database first, even if you don’t use the data that way. The IBI data is saved along with 
the regular, Excel-style data. This means you can come back later, retrieve the session data, and convert 
it to the IBI data format needed by Kubios. 
 
Here is a review of how to save session data properly. 
 

 
 
If you have recorded any data, the Save Session Data Window will automatically open when 
you exit the software (using the lower left-hand Exit Arrow).  You have the option of discarding 
the data or saving the data to a specific client name file.  The names displayed in the 
dropdown box are alias names.  You may select any alias name in the drop down box.  In 
order to verify that the alias refers to the client that you intend, click Verify Name.   
If you did not select a client name before you ran the session, you can click New Client and 
enter client information after exiting the session.  For directions on entering client data see the 
“Managing Client Information” section) 
 
Signal names that are checked will be saved.  You may uncheck those signals that you do not 
wish to save. 
 
  If a specific client was selected before the start of the session, their last set of settings may 
be saved to the client file.  Make sure that Save Settings to Current Client File is checked, 
and Save to Database.  
 
Click Save to Database.  After saving or discarding data, click the X to close the Save 
window. 
 

If you click Export before closing the Save window, you have the option of 
exporting the current session data to Excel or to another database as 
described in the Exporting Data section.  

 
END OF SECTION  
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Managing Data and IBI Conversion 
The place to convert the J&J data file to IBI data format is started here, with Manage Data.  
The IBI conversion takes place in the EXPORT window. Details are given below: 
 
If you are running a session, stop data recording, exit the session to the Physiolab Main Menu 
and click Manage Data.  
It will take you to the View Session box: 

 
In the View Session window, 
select a client alias in the top 
drop-down box. If you wish to see 
the client name, click Verify 
Name.  Select the application you 
used to record data in the second 
drop down box, and then click on 
a session date and time to select 
it.   
 
At this point you can view data 
and generate reports, export data 
to Excel or another database, 
delete data or archive data. 
 

(Troubleshooting Tip: If the session data you are looking for is not present in the session 
window, it was probably collected under a different application name. Select a different 
application in the second drop-down window.) 
 
Deleting Session Data 
If you wish to discard session data follow the steps above to get to the View Session window, 
highlight the session date and time, then click Delete. To delete an entire client record 
including all session data for that client, see the “Adding and Deleting Client Information” 
section. 
 

WHAT GETS CONVERTED?  
So how does this work? Here is a look inside of the IBI conversion file set up fro Kubios Analysis. The 
picture shows a single column of numbers in column A of an Excel spreadsheet . [The Excel spreadsheet 
is not used by Kubios. It is used here to help you visualize how Physiolab converts IBIs.] 
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There is only one column of data, in column A. The scale is in msec. One second is 1000. Here we see 
64 rows, one for each IBI. This is about one minute of saved IBI data. The graph, also from Excel, 
shows the column data as a graph of each IBI by each sequential beat [row]. Note the anomalies, the 
spikes at the beginning and middle of the graph. Kubios software allows you to filter out these 
anomalies and deal with a corrected data file. Since HRV calculations can be distorted by an occasional 
skipped or double beat, this assures that the corrected data file reflects regular HR cycles needed for 
plotting HRV.  

 
 

EXPORT TO Kubios for HRV Analysis 
Here is how to convert Physiolab IBI data to IBI data detectable in the 
Kubios HRV Analysis program. 
Once converted, use the instructions supplied with that program for 
importing and manipulating data. 
 KEY POINT: For those of you who jump ahead, to import the converted 
data, run Kubios, open the folder you saved the converted IBI data, and 
you will at first see nothing. The folder will appear blank. It is not blank. 
Select All Files, and you will see your saved .asc files. Highlight and open. 
 
Now, how do you convert your saved data to  the Kubios format? 
First check that your program does indeed save a signal with the exact 
name ‘IBI_.’ 
 
Does your program save IBI data? Look at the Export Signals list. If it 
shows ‘IBI_’ you can use the IBI export function. If you do not have this 
signal, the IBI conversion will not work. Older programs that have ‘Period_’ 
signals also will not work. 
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The box, HR/IBI only ‘ is unchecked. To activate IBI conversion, check this 
box. 
 

 
Here ‘IBI_’ is an exported signal, so we can check, ‘HR/IBI only.’ 
 
 
NOTE: The other selections on this dialog box are not involved in IBI conversion: Data 
Delimiter, Update, Output and Saved/Export Signals. 
 
You must click Change File to specify an initial target location. 

   
In the pop-up window, browse to the folder into which you want to save the data. You must 
replace the asterisk (*) with a unique filename, then click Open.   
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FOLDER STRUCTURE RECOMMENDATION: If you have a lot of data, think through how you 
will be storing and retrieving each session.  

• If you have two or more groups, consider saving to two or more separate folders. E.g. 
Control vs Experimental. 

•  If you are doing a within subjects design, consider an All Data folder, with subfolder for 
Baselines, Task1, and Recovery, for example. 

 
 
WARNING: OK, not Close.  Do not close the Export Dialog window using the X in the upper 
right corner. The file will not be saved until you click OK in the Export Dialog window.  
 
Automatically Generating Filenames for Export Data 
Once you have used Change File to specify an initial target location and filename, you can let 
Physiolab automatically generate a new filename and export to your initially specified location 
by default each time you export data.   
When you click Export the next time, the target location and filename from your last export will 
be used again unless you specify something different. 

o WARNING: It is important to select Auto Increment in the Export Dialog window 
or the exported data will overwrite the previously saved file with the same 
filename.  When Auto Increment is checked, the number in the Auto Increment 
textbox will be added to your initial filename. 

•  
 When you click OK at the bottom of the Export Dialog window, the data will be exported 
and the Auto Increment number will increase by one integer.   

• RESET AUTO-INCREMENT: You can start Auto Increment over at 
zero or at any other number you choose by typing that number in the 
textbox to the right of the Auto Increment check box. 

 
• MANUAL OVERRIDE: Even with Auto Increment selected, you always 

have the option of manually specifying a unique filename by clicking on 
the “Change File” button, typing your new filename, and then clicking 
Open. The number in the Auto Increment textbox will be added to your 
manually typed filename when you click OK in the Export Dialog 
window to export your data.  This new filename will become the new 
default template filename unless you change it back. 

 
To automatically generate data export filenames using a client name as the filename template, 
both the Use client name as Template and the Auto Increment checkboxes must be 
checked.  
 
Even if you have exported data before using “Change File” to specify a location, you must 
specify an initial target location again when switching to using the client name as a filename 
template. When “Use client name as a template” is checked, the “Change File” button opens a 
window to select a file export location only, without a textbox for specifying a filename.  Browse 
to the data destination folder of your choice, and then click OK to confirm your target location 
and close the window.  Click OK in the Export Dialog window to export your data.   
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EXPORT SETTINGS LAST SAVED: For future data exports, once you have selected a data 
session and clicked Export, your target location and filename will be automatically set and you 
will need to simply click OK to export.  
 
INSTALL HINTS FOR KUBIOS: 
Kubios has a fine installation guide in pdf format. It also provides an excellent review of aspects of 
HRV plots. 

 
Installation instructions 
Windows 
 
Make sure that you have administrator privileges and run the Kubios HRV installer file (KubiosHRV_2.0_installer.exe).  
 
Follow the instructions given in the setup wizard to complete installation. You can launch the Kubios HRV by selecting it from the 
created Start Menu folder or by clicking the Desktop icon (if created). Please note that the starting of Kubios HRV also starts the 
MATLAB® Compiler Runtime and may take some time especially with older computers. 
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Figure 1. Register to ask for downloads. Read carefully. Clinician-researchers qualify. 
 

 
Figure 2. You will receive an acceptance or denial. 
 

 
Figure 3. Here is an acceptance. Go to the link provided. 
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Figure 4. Download and save. 
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How To OPEN IBI conversion Files: 

 
 
Figure 5 Problem starting? Run as Administrator. 
 
 

 
Figure 6 Deselect 'Protect ..." to run in Admin mode. 
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Figure 7 Enter your User Info, then go to analysis Option... 
 
 

 
Figure 8. Select RR Interval... 
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Figure 9. At first, select none for RR Detrending.. 
 

 
Figure 10. Unless instructed otherwise, keep these at the default values. 
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Figure 11. Select your printer's default paper type. 
 

 
OPEN the Physiolab IBI data file. Not sure where you saved it? Do a search  on .asc file extensions. 
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Figure 12. This folder is not blank. Select File Type - All Files. 
 

 
 



PHYSIOLAB Engineering 2009 - USE3 Plus USERS MANUAL page 25 of 50 pages. 
 

 
Figure 13. Select the file for analyis. Here we look at rng_2_1.asc. 
 

 
Figure 14. Here is the raw IBI data. We want ro correct for artifact... 
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Figure 15. Very strong artifact correction filters some extremes. Time domain is more normal, too. 
 
 

 
Figure 16. What about HRV Frequencies? Click on Frequency Domaine. 
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Figure 17. Click on non-linear for Poincare plots and detrended plots. 
 

 
Figure 18. Done? Save to ASCII text file for use in an Excel or statistical package. See Kubios manual for options. 
 
 
REMINDER: You must set up the defaults properly to code your data. Use the client file name, auto-
increment, autosave and include client info. 
 
KUBIOS IBI IS NOT COMPATIBLE WITH EXCEL IBI. 
Remember that if you have other data like respiration, temperature or EMG as Exported Signals, you 
can save that data to Excel directly, and select form the spreadsheet other types of analyses. Excel also 
exports an ‘IBI_’ column of signals, but they are not like the IBI conversion files. These IBIs are 
averaged every 1/10 second, and will show a different distribution of signals than the IBI conversion. 
We recommend using HR as the primary beat data for Excel and exclusing IBI data from Excel 
comparisons. 
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APPENDIX: 
Archieving 
Before too long, you will run out of space to save your session data. Physiolab has a 1 GB limit to stored 
data. And you really need to back up your saved data anyway, in case your computer crashes in the 
middle of your study. Here is where you need to learn to archive your data every work day. 
 
Archiving Session Data 
Achieving is essential to back up your data files, to protect in case of computer failure, and to 
sort sessions together in a research project. 
 

SIDEBAR: Archiving to a folder can be very beneficial for supervision. 
Your interns can email session data for a single client or a group of clients.  
Researchers can archive session data by protocol, for example, putting all pain clients 
into a pain-stress profile folder. 

 
 
One GB Maximum Limit on stored data for all sessions.  
The achieve function is critical housekeeping for your data. 

•  
After 1 GB of data is reached, the program 'dumps' the oldest files. ‘Dumped’ 
files can not be retrieved.  

• As a caution, PHYSIOLABhas added an automatic  'warning' pop-up message 
when the data folder is reaching maximum, but do not rely on it.  When you have 
stored ½ gigabyte of data, you will start getting messages suggesting that you 
archive files.  It is important to respond to these prompts and archive data since 
you will not be able to access session data if the 1 gigabyte maximum database 
size is reached.  

•  
 
 
 

YOU CAN ARCHIEVE DATA IN TWO WAYS: 
• Achieve by Backing up [ archive by copying]. 
• Achieve by Clearing [achieve by moving ] 
• Delete File You can also just ‘delete’ a file. Once deleted,    Physiolab can not retrieve a' 

file. 
 
All patient data is saved into the same Physiolab file, called  data.mdb .   

FINDING data.mdb: To find it, use Windows search: ‘data.mdb’. There is one data.mdb 
file for each separate PHYSIOLAB Suite. There is one data.mdb fro the Bundled Suite, 
another for the ‘Classic Suite.’  If you purchased and installed additional suites, there 
will e another data.mdb for another for each:  e.g. ‘Neurosuite,’ etc. Back up and 
archieve each one separately. 

To archive data, click Manage Data on the main entry menu, and then click Archive.  
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• In the Archiving window, select a client alias name in the Main Database drop-down 

box.  
• Select an application that has data for the client in the top drop-down box.   
• To select a target folder location for your archived files, click the small button to the 

right of the Archive textbox.   
• Either select an archive file name in the Open window (if you have previously archived 

data) or browse to the folder location where you wish to create a new archive, type a 
new name in the “File name” box, like ‘stress profile-01.mdb,’ and click Open.   

• You can choose to have a separate database file for each client or you can archive files 
by time period (quarterly, half-yearly, etc.) 

 
• Back in the Archiving window, click on the date of a session in the list to the left, and 

then click the right arrow to move it into the list of files to be archived.   
• You can select and move all files in the list or you can pick and choose sessions by 

holding down the Control key while clicking on those you wish to archive.  
• Finally, click Compact Databases to free up space in the Physiolab database, confirm 

by clicking yes, and click Close to exit the window. 
 

o COPY ONLY: You can copy a file for a colleague, and keep the original in 
data.mdb. 

o If you wish to copy a file into a new data location, while leaving the original file in 
place, follow the procedure for archiving files, but click the Copy dot before you 
click the right arrow to move files into the right side of the Archiving window (This 
does not free up space in the data.mdb file). Click Close to exit the window. 

 
MOVE BACK: You may receive a file from a colleague. To view it, transfer the 
file back using Archieve window. At any time you can move archived files back 
into the original Physiolab database to view them.  Follow the same procedure 
for archiving files, but select archived sessions in the right side of the Archiving 
window and use the left arrow to move them back into Physiolab. However this 



PHYSIOLAB Engineering 2009 - USE3 Plus USERS MANUAL page 31 of 50 pages. 
 

only works if you have the same application installed. If someone sends a stress 
profile, and you do not have that profile in your PHYSIOLAB applications already, 
you can not move it back or view it. 

 
Using Excel: 
In addition to IBI conversion, Physiolab allows you to export data in spreadsheet format. Data is usually 
saved in ‘raw’ formate at 10 imes per second for each channel. Yo have the option od exporting at 
slower sample arters like 1 per second or 10 per minute, in which case the resulting data is averaged as it 
enters Excel or your statistical package. 
 
Creating Excel Reports 
 

Click on the Generate Report button .  Accept the default or select the desired averaging 
interval for your report, click Excel Report.   
 
You will see a pre-formatted report generated in Excel with the current Session Review Screen 
image inserted into the report. You will be prompted to save your report.  Browse to your 
desired folder location and give your Excel report a name, then click “Save”.  To view or print 
your report, insert text, or chart data you will need to re-open the report from the location 
where you saved it. 
 
You can insert rows and merge cells to create text boxes for expanding and personalizing 
your Excel report. Click on the row number to the left above which you wish to insert rows of 
text. Click on Insert>Rows. Repeat this to insert as many rows as you wish. Left-click on the 
cell where you want the top left corner of your textbox to be. Holding the left mouse button 
down, drag the cursor down and to the right to highlight the number of rows and cells desired. 
In the top menu choose Format>Cells. Click the Alignment tab. In the “Horizontal” drop-down 
box choose “Left”.  In the “Vertical” drop-down box choose “Top”. Check “Wrap Text” and 
“Merge Cells”. Click OK. You now have a text box in which to insert paragraphs of text.  It is 
best to start with a text box slightly smaller than you think you will need.  If you need a larger 
box, click in the existing text box and, holding the left mouse button down; drag the cursor to 
highlight cells to the bottom and/or right. . In the top menu choose Format>Cells. On the 
Alignment tab, click “Wrap Text” and “Merge Cells”. Click OK. 
 
You can use the Excel Chart Wizard to create graphs. Select single columns of signal data 
because Excel can only chart one scale at a time. 

Click the Chart Wizard Icon in the top menu.  
 
Select the type of chart you want. You can try out different options and view them in the 
preview window to see which displays of the data are most effective. You may find that your 
sample rate is too high or too low to create a meaningful chart.  You can re-send the report to 
Excel at a different sample rate using the Excel Report button, resave it to a new filename, and 
re-chart it using the Excel Chart Wizard.  
 
You can save your Excel report using the File>Save menu commands and/or print out your 
report using the using the File>Print commands in the Excel menu bar. 
 
Exporting Data to Excel or Your Own Database 
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Exporting to EXCEL  is an easy one-button process, once the two programs – PHYSIOLAB 
and Excel have been configured properly. 
 
First run a program and EXIT and SAVE. 

• You can save twice if you would like, once to J&Js 'Save to Database,' and once to 
'EXPORT.' However it is safest to ALWAYS save to J&Js Database BEFORE 
exporting. You can export J&Js data files at any time to Excel, but if Excel is not 
working or you erase the spreadsheet, you can only recover by retrieving J&Js Datafile. 

So to Export, just select EXPORT from the Data Management Window, check off the signals 
and Update times and press OK. 

KEY POINT: There is a Maximum of 29 allowed Exported Signals   
Many applications save more signals than are needed for research. For example, 'HR-
Above' is a signal that counts the number of beats above a HR threshold. This is not 
usually needed for research, so you may wish to 'remove' it [use the back arrow] before 
exporting to EXCEL. 

 
Exporting data does not affect the original data record.  It only exports copies of the data.   To 
export data, first follow the instructions for selecting session data under the Managing Data 
section above.  Then click Export.  
 
In the right side of the Export Dialog window, uncheck any information you do not wish to 
include. In the Update drop-down box, choose the update rate, which is the averaging 
interval time in seconds (decreasing the rate reduces file size and makes charting the data 
more feasible).  
 Select either Average Only or Basic Statistic (described in the Quick Reports section).  If 
you don’t want to export all of the signals, highlight individual signals and move them into the 
Saved Signals box using the left-arrow. 

 
NOTE: There is a Maximum of 29 allowed Exported Signals. 

 
If you wish to export to Excel, select Excel in the Export Type box and-click OK.  Click Yes in 
the save prompt pop-up window, browse to a folder location, type in a unique filename and 
click Save.  If you wish to include screen captures in your Excel report, or add textboxes or 
charts, you may want follow the directions in the Creating Excel Reports section instead of 
exporting data. 
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If you wish to have Physiolab automatically generate filenames and save to a pre-selected 
target location, check the Auto save checkbox, and then follow the instructions below in the 
Automatically Generating Filenames section. 
 
When Auto save is checked Excel will pop open and populate with data, then the save window 
will briefly appear and disappear as the file is automatically saved to your target location, and 
Excel will close.  It may take a few minutes for these steps to execute, especially with large 
files. 

 
 
 
TROUBLESHOOTING: 
Some users have reported getting Export Errors.  
                The General Exception error provides a spreadsheet with no data columns.  
               A more frequent error is the a warning of Excel for a moment as the data is written to 
the spreadsheet, then the whole Excel program disappears. 
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SOLUTIONS: 
A careful, step-by-step analysis of this problem revealed no apprent problems with the 
PHYSIOLABExport program as a whole; however users with these errors can get it to export 
properly by spending a little time re-configuring the Export Window.  
Here is how to get it working again: 
1. Change Update Unit: Trial Length or 10 sec. seems best for troubleshooting. 
2. Use Average Output, not Basic Statistics. 
3. Remove [<--] all Signals except for the most basic EMG, HR, Sc, Temp, SUDS, etc: 
 
After each step, press OK to test that EXCEL is now working. 
 

 
It appears that some attempts to export to Excel  do not synchronize cells in the right 
order for Excel.  Once  the PHYSIOLABExport Window is re-configured, these problems 
go away, and everything works. 
By re-configuring the Export Window users have been able to 'recover' data sets that 
many researchers thought were corrupted or beyond salvage.  
 

BOTTOM LINE:  
DO NOT ERASE 'BAD' DATA. Save them, and Archieve them.  [See How to Archieve]. 
 
After Archieving, get hold of Dr. Grove through J&J. He will instruct you to send them to Dr. 
Grove at a special email address for analysis. 
 
Reminder: Excel may take take a long time to fill a speadsheet. So be patient and do 
nothing until you see the opop-up window: 
"Do you want to save the changes you made to Book 1?' 
Answer Yes to have it Save as 'book1.' This is not recommended, and is only if you are in a 
hurry! 
Click on Cancel, and then "Save As" .. in a follder for later Excell Analyisis. 

 
LIMIT ON NUMBER OF SIGNALS IS 29. 
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A few applications save more than 29 signals. Some  Excel programs limit the number of Excel 
exports to 29 signals. To see if you have more than 29, count up all the Exported Signals. 
Solution: Move unnecessary signals to the left side box, Saved Signals. 
When you are left with 29, press OK. 
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EXPORT TO ACSII: [ NOT EXCEL] 

If you are using your own database program, use the instructions supplied 
with that program for importing and manipulating data.  

 
If you wish to export to another database, select Asci in the Export Type box. 
You must click Change File to specify an initial target location.  In the pop-up window, browse 
to the folder into which you want to save the data. You must replace the asterisk (*) with a 
unique filename, then click Open.   
 
It is important to specify which symbols your database will be looking for in order to interpret 
divisions between data elements.  Click the radio button next to the appropriate symbol 
combination in the “Data Delimiter” box.   
 
Do not close the Export Dialog window using the X in the upper right corner. The file will not be 
saved until you click OK in the Export Dialog window.  

 
 
Automatically Generating Filenames for Export Data 
Once you have used Change File to specify an initial target location and filename, you can let 
Physiolab automatically generate a new filename and export to your initially specified location 
by default each time you export data.  When you click Export the next time, the target location 
and filename from your last export will be used again unless you specify something different. It 
is important to select Auto Increment in the Export Dialog window or the exported data will 
overwrite the previously saved file with the same filename.  When Auto Increment is checked, 
the number in the Auto Increment textbox will be added to your initial filename. When you click 
OK at the bottom of the Export Dialog window, the data will be exported and the Auto 
Increment number will increase by one integer.  You can start Auto Increment over at zero or 
at any other number you choose by typing that number in the textbox to the right of the Auto 
Increment check box. 
 
Even with Auto Increment selected, you always have the option of manually specifying a 
unique filename by clicking on the “Change File” button, typing your new filename, and then 
clicking Open. The number in the Auto Increment textbox will be added to your manually typed 
filename when you click OK in the Export Dialog window to export your data.  This new 
filename will become the new default template filename unless you change it back. 
 
To automatically generate data export filenames using a client name as the filename template, 
both the Use client name as Template and the Auto Increment checkboxes must be 
checked. Even if you have exported data before using “Change File” to specify a location, you 
must specify an initial target location again when switching to using the client name as a 
filename template. When “Use client name as a template” is checked, the “Change File” button 
opens a window to select a file export location only, without a textbox for specifying a 
filename.  Browse to the data destination folder of your choice, and then click OK to confirm 
your target location and close the window.  Click OK in the Export Dialog window to export 
your data.  For future data exports, once you have selected a data session and clicked Export, 
your target location and filename will be automatically set and you will need to simply click OK 
to export.  
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RESEARCH MODE: Setting Up Tasks & IBI 
Some researchers wish to run sequences of events and need to set up a strict protocol. This 
section is a guide to what we call Task Sequencing. It is a  little confusing until you figure out 
that each segment must be saved as you proceed. Saving here is called ‘updating’ a profile. 
 
Researchers have requested simple ways of presenting a sequence of tasks that are 
standardized in time per task and in content. A stress profile is a common example. You can 
record many signals in the standard way, and export them to Excel for spreadsheet analysis. 
However to conduct a Kubios HRV analysis, you will need to save the data as HR/IBI format, 
and mark each task manually. More on this later. 
 
First, how do you set up your own sequence of tasks? 
Tasks are data recording intervals which can be named to enable interpretation of session 
data.  Task interval marks and color-coded time interval bars are inserted into the graphic 
record.  Task labels are inserted into the recorded data file.   
 
 Specifying Tasks Manually 

To manually set up tasks, click on the Select Task icon  in the bottom Session Control 
Toolbar.   

 
 

In the Programmed Task Schedule window, you can select different task labels manually at 
whatever time intervals you wish. In the lower left-hand corner click Manual Task to create a 

check mark. Click on the desired task name to highlight it, and then click Run Selected Task.  
The task name will appear in the task progress bar at the bottom of your screen and will be 

inserted into the recorded data.  When you are ready to change tasks, repeat the above steps, 
highlighting a new task name.  Click the record icon to start recording the task.  You can 

change the task name while recording or you can opt to click the Pause button between tasks. 
 
Running Preset Programmed Tasks 

Click on the Select Task button  in the bottom Session Control Toolbar to bring up the 
Programmed Task Schedule window.   In the Select Schedule drop-down box select a Task 
Schedule name.   
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The list of tasks in that schedule will appear in the large task status box.  Click on a task name 
in the list and click Run Selected Task. 

 
Scheduled tasks are set to either progress on to the next task immediately or to pause before 
starting the next task.  Check marks will appear in the task list next to each task that has been 
run and recorded in the session.  If a preset task stops recording and the green “Pause” status 
message is flashing, you can opt out of the timed pause by clicking the Pause ON/OFF button 
to immediately run the next task. 
 

• To manually pause while a task is running click the Pause ON/OFF button.  Re-click the 
Pause button to the resume the task.   

 
• To stop a task before it is finished and move on to the next task or to skip to a later task, 

click Record ON/OFF, then the Select Task button. Click on the name of the task you 
wish to run, then click Run Selected Task. 

 
• To cancel a task schedule before it is finished and exit the session, click Record OFF. 

Then exit the session using the lower left-hand exit arrow and either save or discard the 
data. 

 
When a schedule of tasks finishes running, the final task will remain 
paused until you click the exit arrow. 

 
You may run each task once per session.  To maintain data integrity, the data must then be 
saved and the session exited before you can run the same tasks again.   
 
Customizing Programmed Tasks 
You can create multiple task schedules with unique customized tasks in each.    
The easiest way to start is to modify an existing task schedule for your own unique needs.  
When you finish modifying tasks as outlined below, be sure and  
Click Update Schedule to save all of your changes. 

To begin, first click on the Task  button, then click Edit Mode On.   
Click the Select Schedule drop-down box and click on the task schedule name that most 
closely matches the list of customized tasks you wish to create. 
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You may move tasks up or down in the list, add new tasks to this list, delete tasks from the list, 
and modify the remaining tasks.  Each task must be customized individually.  (If the task you 
want to modify has already been run during the session the Task Properties button will be 
grayed out and you must exit the session and re-enter a new session before modifying the 
task.)  Highlight the name of the task you wish to customize, and then click Task Properties. 
Click Advanced to expand the window. 
 
In the Task Properties window you can edit the name of a task by simply typing over the 
existing task name (TIP: This task name may function as an instruction to the client since the 
task name is displayed at the bottom of the feedback screen).  “Category” is an optional sort 
field not used in the current USE3 View function. 
The Start Screen drop-down box should be left at NONE unless you want the program to jump 
to a pre-selected screen at the beginning of the task.  
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If you do wish to jump to a particular screen, select the screen name in the Start Screen drop-
down box.  Specify a Task Record Time in seconds.  Choose “This task bar only” to display the 
progress bar for this single task across the entire width of the screen.  Choose “All task bars” if 
you wish the progress bar to show progress through all of the tasks in the task schedule. 
 
You can loop through a single task or through a series of tasks a specified number of times. 
Check Loop then select the name of the task that you wish to have as the start of your loop.  
You may only loop back to tasks in the list that are above the currently selected task. (NOTE: 
You will need to click the drop-down arrow and the tiny scrollbars to see all the tasks in the 
list.)   
Type in a Number of Loops to indicate the number of times you want the program to loop 
through the tasks before it moves beyond the loop to the next task in the list. 
 
If Pause Record on Start is unchecked, recording will automatically start at the beginning of 
the task and continue for the number of seconds you specify in the top right Task Record 
Time box. 
 
You may set a pause at the beginning of the task and let the task auto run so that the task 
begins recording after the time interval that you specify.  Check Pause Record on Start and 
specify a number of seconds in the Pause and Text Time box in the middle of the window.   If 
you wish to manually start each task, you will want to specify a long pause time at the 
beginning of each task.  When you run the task, click the Pause ON/OFF button to manually 
override the pause and begin the task.   
  
Programmed Tasks: Instructional Text Boxes 
If you wish for a text box with instructions to appear at the beginning of the task, you can select 
one of the text instruction files in the Select Name drop-down box.   
 

• Click Test Text to position and resize the window and to view the text.  USE3 Physiolab 
comes with a large selection of instruction text files but, if you wish to add your own, you 
can create text files and save them into the C:\Program Files\PHYSIOLAB 
Engineering\Physiolab\Text folder.  These files must be in .rtf file format and must have 
unique file names.  If you wish to change the wording of J&J’s instruction files, click Edit 
Text after selecting the filename that you wish to edit.  Be sure to click Save As and 
change the file name so that your customized files will not be overwritten during 
software updates. 

 
• Check End text window on pause or record click if you wish the test instruction 

window to close when recording begins (either an auto run pause times out or you click 
Pause ON/OFF to manually override the pause). 

• If End text window on pause or record click is unchecked the text window will appear 
during the entire length of the task.  NOTE: You must click Test Text and resize the 
window in order for the text to display properly.   

 
If you wish a task to be instructional only, with no data recording, check the Record Off box. 
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Programmed Tasks: Audio Files 
USE3 Physiolab comes with many audio files which you may elect to play when the task starts, 
when recording starts or at the end of the task.  

• Text Window Start files are alert beeps or verbal instructions up to one minute in 
length.  To play an audio file at the beginning of the task, check Text Window Start and 
select an audio file name in the drop-down box to the right.  

• Record Start audio files may be used as alert tones or as stressors (i.e. baby crying) in 
a stress profile task.  To play an audio file at the beginning of recording, check Record 
Start and choose an audio file name in the drop down list. 

 
• If Pause Record on Start is checked, you may specify both Text Window and Record 

Start sounds since the text window will appear at the beginning of the task and 
recording will start later.  If Pause Record on Start is unchecked, then the text window 
will display at the same time that recording starts and only the Text Window Start audio 
file will be heard. 

 
• Task End should be used with care.  You may not have both an ending audio file for the 

current task and a beginning audio file for the following task.   If you specify both an 
ending sound for the current task and a beginning sound for the following task, then the 
ending sound file will be overridden by the following start task audio file. 

 
The easiest way to become familiar with USE3 Physiolab audio files is to go to the C:\Program 
Files\PHYSIOLAB Engineering\Physiolab\Sounds folder and double-click on each WAV format 
audio file to play it. The subfolders are sounds that are used in game feedback screens and 
are not available as task sounds.  You may add your own files to the Sounds folder.  They 
must be WAV format audio files and have unique names so that they will not be overwritten 
during software upgrades. 
 
Creating Your Own Programmed Tasks 

• Start by clicking on the Select Task icon to open the Programmed Task Schedule 
window. Click Edit Mode On.  Click in the top Select Schedule box and type a new 
unique name for your task.  (Naming Tips: This name cannot be edited so choose 
carefully. If you want a particular Schedule to appear at the top of the list keep in mind 
that schedule names are arranged alpha-numerically in ascending order.)  Click Add 
Task.  Then follow the same process for each task as outlined in the section on 
Customizing Programmed Tasks above.  If you wish to add a new task in the middle of 
the task list, click on an existing task name above which you want the new task to 
appear. Click Insert Task and proceed to create the task in the same manner as for 
adding a new task. 

 
• After you have specified settings for each task, click OK in the middle of the Task 

Properties window.  When you have finished setting up all tasks, click Add as New 
Schedule in the Programmed Task Schedule window to save your settings.  

 
Saving Programmed Tasks 
After you finish modifying or creating each task you must click OK in the upper portion of the 
Task Properties box.  If you click Cancel or close the window with the X your settings will be 
lost.  If you are finished modifying tasks for an existing task schedule, click Update Schedule.  



PHYSIOLAB Engineering 2009 - USE3 Plus USERS MANUAL page 42 of 50 pages. 
 

If you are finished adding new tasks to a new Task Schedule, click Add As New Schedule at 
the bottom of the Programmed Task Schedule window. 
 

COMMENT: The settings for Task Schedules will be lost when you upgrade your 
software since they are part of the updated application. You can keep your current 
(older) version of the application with your customized tasks by going to the C:\Program 
Files\PHYSIOLAB Engineering\Physiolab folder and renaming the .mdb file for each 
application you wish to save.  These renamed customized applications will be not be 
updated.  When you start USE3 Physiolab and click Run Session, two identical 
application names will appear in the application list.  Find the one with your customized 
tasks and run that one until you have time to customize your newer version of the 
software.   

 
We recommend that you print screen captures of Task Properties windows for all of your 
customized tasks so that you can re-create them in the upgraded software. (Instructions: Open 
the Task Properties window for each task and click Alt+Print Screen on your keyboard, then 
open Start> Programs> Accessories > Paint.  In the Paint program click Edit, then Paste.  
Click File, then Print.)   
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 TROUBLESHOOTING 
Our system is very reliable. Nevertheless, like all biomedical devices, there are many processes that must occur 
to detect, transduce, filter, and display a signal. Some of the  more common issues are listed here: 
INSTALLATION PROBLEMS: 

 
"INVALID DATABASE"  Error? 
Keep this in mind - sometimes a download is corrupted by the transfer process and when you run it, you get an 
'invalid database' error. 
The soultion? Download again - until you get a full set. 
VISTA users - if you get this error, the download may be corrupted AND/OR Vista is blocking you. Vista by 
default is set to block almost everything, because you are not installing as 'administrator.' The Vista Solution is to 
right-click, and select ' Install as Administrator.'  
 
Then disable the User Acconts. 
Go to Control Panel -> User Accounts -> Turn On / Off User  
 
SIGNAL PROBLEMS: 
EEG/EMG/ECG: The greatest problem is poor skin preparation. First check the electrodes alone. Take off the 
sensors and touch each + and - lead to a Ground. Impedance should drop to near-zero. OK? Then the problem is 
with the skin: Use a circular motion to rub the site first with an abrasive material, then alcohol, then a dry swab. 
The skin should look slightly red with local blood flow. Then dab a dot of electrode cream on the site and attach 
the pre-creamed electrode into place. If you pre-gelled EMG electrodes, put some cream on the electrode and 
site anyway. 
SIGN ON PROBLEMS?  
If your computer sometimes has problems signing on, there are 4 reasons:  

 
1`. Low battery. Battery voltage is 6.5 V max and 4.3 V  min.  
2. Wrong hardware type. See RUN SESSION/ Setup/Hardware Type. 
3. Competing programs are knocking out access to the processor - you MUST turn off and remove 
Internet, Norton, defrag, scanner virus and anti-spyware. 
4. The fourth reason may be that your Vista operating system is not optimized for 'feedback. You may 
need to reinstall PHYSIOLAB Applications as  as Administrator,  
5. You have a computer that is not optimized for fast signal processing and screen drawing. If you have 
solved the first two problems, and still can not sign-on, strip everything out of the computer, re-install XP 
or Vista, delete all anti-virus and internet programs, and reload PHYSIOLAB USE3 Plus. 

 
INTERMITTANT  SIGN ON PROBLEMS? 
Intermittant problems usually are caused by an intermittent failure in some part of the computer. 
If your computer sometimes has problems signing on, try this:. 
Turn off and remove Internet, Norton, defrag, scanner virus and anti-spyware. 
4. The fourth reason may be that your Vista operating system may have updated and reset some internal 
Administrator file. Save your old data.mdb file and reload the program. 
5. You have an old computer. If you have solved the first two problems, and still have sign-on problems your 
CPU-Video card combo may be failing. 
How do the Impedance Bars work? Are they the same in every application?  
The impedance bars are set by each application developer and generally 100K for EMG, 200K for ECG, and 10K 
for EEG is used for the yellow green threshold and about three times that for the red yellow. 
DATA MANAGEMENT PROBLEMS: 
General Exception Error – see DATA MANAGEMENT-EXCEL TROUBLESHOOTING. 
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Installation and Update Instructions 
 
System Requirements 
The operating system requirement is Windows XP or later with all Microsoft updates.  

• Computer: The minimum hardware requirements are an Intel- or AMD-based processor 
at a  speed of 1.6 Gigahertz, 1 KB or more of RAM and a video card with at least 128 
MB RAM.   

• Second monitor: In order to use the optional dual monitor mode, you will need to run the 
software on either a laptop computer or on a desktop computer with a dual head video 
card.  

• We strongly recommend isolating the computer that runs our software. Outside 
programs for Internet connections, defragmentation, malware sweepers, anti-virus, and 
even Microsoft’s background Vista utilities [Vista restore points run all day in the 
background and are not detectable on the desktop] have been reported to slow down or 
interfere with data collection.  Users who dedicate a computer to our system and isolate 
it rarely contact us for software problems.  

If you want our recommended computer, we have found that the $360 Asus  eee 1000 netbook 
series running XP on a virtual 1024 x 768 is more than adequate. It runs our most processor 
intensive 4 channel EEG and EMG intensive programs with no problems. 
 
Recommended Additions: 
1. USB-ONLY SPEAKERS: 
Most users report no problems with XP or Vista audio. However some users of Vista and a few 
with XP experience a frustrating sound problem: trying to activate more than one sound 
together with another sound may disable all sounds! Not only that, but the problem persists 
until you exit and re-start the computer. This means you have to exit and restart to regain 
sound control. That’s frustrating.  
This is a hardware problem, not a bug. Unless you have this problem, this discussion does not 
apply. 
 

The culprit is a laptop or desktop with a cheap audio card. The cards amplifiers saturate 
/ overload and shut off further input.  

• Vista is most sensitive to sound saturation problem because Microsoft switched 
requirements for sound amplifiers. Our testing also indicates instabilities in Vista 
itself cause audio problems. 

• The solution is to purchase USB-only speakers. These speakers disable the 
native audio driver and run high quality USB audio, even Dolby audio,  directly 
into USB-powered amplifiers.  

• Look carefully- these special speakers never have plug-in to the earphone jacks. 
THEY ONLY HAVE USB CONNECTORS. If yours has a USB and a standard 
headphone-like jack, do not purchase it! Some speakers use a USB port just to 
power their speakers, not as sound-boards.  

• The USB-only speakers include an internal motherboard audio digital decoder 
plus an amplifier, hidden in one speaker. The decoder and speakers require a 
USB port. Do not confuse them with traditional speakers that plug into a stereo 
phone jack. Those old speakers will not work.. 

•  
2. Add an Extended Monitor and run in ‘Dual’ or ‘extended’ screen mode” 
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You can of course share your screen with clients. Field reports universally confirm that this is a 
bad idea. Clients are confused and distracted by toolbars and windows icons. If you are in a 
place where to are forced to use a single screen, try turning all toolbars off [see View drop-
down menu].  A better solution is to add a second monitor, and adjust it for the same resolution 
as your primary monitor, 1024 x 756. Monitors range from 15” for about $120, to VGA 
projectors covering an entire wall. 
 

 HARDWARE LOCATION – CABLE EXTENSIONS: 
Keep the Physiological Amplifier at least 3 feet away from 
electronic equipment, especially laptops, monitors and printers. 
Florescent fight flicker can cause interference. Do not use USB 
wired extension cords. We have tested commercial wireless USB 
2.0 devices from D-Link and they work well up to about 15 feet. 
We also have an extension cord from the Amplifier input to the 
sensor cable. This adds 3 feet, giving you about 6 feet to the 
sensor. This is good for groups or for movement physiology.  
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 Viewing Session Data and Generating Reports 
As a researcher, use view data as a quick way of eyeballing your session results, even if you 
need to export to Kubios HRV. 
 
The View function gives you the ability to review session data in a graphical environment, 
replay signals, print screens and generate reports. Follow the instructions for selecting session 
data under Managing Data section above.  Then click View.  
 
A screen will pop up. IF THE SCREEN IS MOSTLY BLANK, click anywhere, and a screen 
graphic will be written. It will NOT be to scale. You must highlight a graph, adjust the screen 
sweep, and then adjust each signal for the optimal view. The result will look something like 
this: 

 
This is a Report generated from View. It is a full stress profile. Originally the signals were not 
as detailed as they are shown. It was necessary to highlight each graph, and change each 
signal’s view, as explained below. 
 

Changing Signal Views 
In the Session Review Window, you can replay the session signals, selecting and adjusting 
the signals using the buttons in the Signal Control Bar in the same way as if you were 
running a session.   
 
If more than one screen selection button is present at the top of the window, you can use them 
to select the signal grouping that you wish to view. 
 

• If the signals are against the top or bottom of the display area, you must select the 
signal by clicking on the colored box in front of the signal name, then use the Signal Up 
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 or Signal Down button  to manually adjust the height of the signal.    (You 
must first turn Auto gain and Auto-offset Off.) 

 

• Using the Faster Graph button  and Slower Graph button  you can change 
the amount of session time displayed within the window, from focusing on a small 
segment or single task to condensing an entire session onto one screen.   

• Use the Show/Hide Signals button  to zero in on just one signal or any 
combination of signals. 

 

• With the  Averaging buttons in the bottom Review Session Bar, you can 
increase or decrease the smoothing of the signal. Click multiple times until you reach 
the desired degree of smoothing. 

• Use the Rewind, Scroll Forward, Scroll Back, and End buttons 

o   
To navigate through the recorded session. 

 
• You can hide and re-display: 

o Task Markers with the Task Mark button   

o Event Markers with the Event Mark button    

o Task Bar with the Task Bar button  and the 

o Digital Cursor with the Digital Cursor button . 
 

 When the Digital Cursor is toggled on, you can click anywhere in the 
display to create a vertical cursor line.  The signal values at the point 
where the cursor bisects each signal line are displayed next to the signal 
names as shown below: 

 
 
 
Printing Screen Images 

• When you have adjusted the signal displays as you want them to appear, click the Print 

Screen button  in the bottom toolbar.  Wait a few moments for the screen image to 
appear.  



PHYSIOLAB Engineering 2009 - USE3 Plus USERS MANUAL page 49 of 50 pages. 
 

 
• Click “Print” in the top menu, modify printer settings as needed, and click OK.  You are 

given the opportunity to abort without printing by selecting “Close” instead of “Print”. 
 
Saving Screen Images 

• In addition to printing a screen image, you have the option of saving a screen image as 

a graphics file.  Click on the Save Picture button .  In the window that appears, 
browse to the location where you want to save the image file in the top drop-down box.  
Give the file a unique filename and click OK. 

 
Printing Quick Reports 
You can fine tune your data views by adjusting the signal displays then printing Quick 
Reports.   

• First select a client, an application, and a session as described above in the”Managing 
Data” section.  Manipulate the signals to obtain the screen view to be inserted into your 
report as outlined above in the “Changing Signal Views” section.  Then, to print a pre-

formatted Quick Report, click on the Generate Report button  button. This brings up 
the Generate Report window. Accept the defaults or use the checkboxes to designate 
the types of information to be included.  Select a different averaging interval or accept 
the default.  Accept the Average Only default or choose Basic Statistics.  Average 
only includes mean averages for each signal over the selected interval.  Basic Statistics 
includes standard deviation, minimum and maximum for each interval. 

• Click “Print Quick Report”. 
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Help? 

 
Want help? 
Contact Robert Grove at the address on the first page. 


